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Installing TrialWizard 
You will have received an e-mail with a unique link to your own installer. Click on the 

downloaded .msi installer for TrialWizard. Select “Run” and follow instructions. It is best to 

use the default settings for installation on your PC, so hit the buttons ‘Next’,  ‘Next’,  ‘Next’ 

and ‘Close’.  

Some computers have high security settings, preventing the installation. In that case, log on to 

your computer as ‘Administrator’ and try again. 

The installer program will place a shortcut to TrialWizard in your Windows start menu and on 

your desktop.  

If you start TrialWizard for the very first time, you will see a screen like this: 

 

The request code is unique, for one computer only. Send an e-mail to 

trialwizard@beerepootconsultancy.com with this request code. You can paste this code into 

the e-mail (using Ctrl-V). Usually within a working day, you will receive an e-mail back, 

containing a license code. Type or paste this license code in the screen shown above and hit 

‘OK’.  

Now, TrialWizard should be ready for use. 

mailto:trialwizard@beerepootconsultancy.com
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Where are the files of the trials? 
Each trial has its own *.TWZ file, containing all information on that trial, such as variety 

names, trial plan and observations already made. 

By default, all trial files are placed in a folder called ‘Trials’ in your ‘My Documents’ folder. 

 

You can make folders within the  ‘Trials’ folder. You can also store trial files elsewhere, if 

you want. However, don’t rename or remove the ‘Trials’ folder! 

TrialWizard has certain options, such as  to find varieties or rename varieties across different 

trials, which work best if all trials are in the ‘Trials’ folder or folders within that folder.  
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Getting started 

Start the TrialWizard program by clicking the TrialWizard icon on your desktop or in the 

Windows Start menu. You will then see the following start screen: 

Before you have selected a trial to work on, all 

“Trial design” and “Results” menu items will 

appear dimmed (grey). 

 

A trial must now be selected, before you can 

select a menu item.  

After any task done with TrialWizard, you will come back to this start screen again. 

Start working on an existing trial 
From the “File” menu, choose “Open”. Alternatively, push the button with the open folder 

icon (second from left), or use the Ctrl+O shortcut. 

 

This will first reveal a standard Windows “Open File” window for .twz files. It starts looking 

in the “Trials” folder, but you can also go to other folders and directories, using standard 

Windows techniques. 

Select a trial of your choice, after which 

you will come back to the start screen 

again.  

 

 

 

 

 

The name of the chosen trial will now be 

displayed on the start screen: 

 

Start a task by choosing any of the 

appropriate menu items, buttons or 

shortcuts.  
All tasks are accessible by selecting a 

menu item. The most common tasks also 

have buttons on the start screen. 

To quit TrialWizard, press the red 

“Stop” button. 
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Designing a new trial 

At the start screen, choose “New” from the “File” menu.  

Alternatively, push the New Document button as shown on the left: 

 

The following small window will appear: 

Type a name for the new trial, e.g. “Winter wheat IV 2003”. After this, press OK. 

 

Next, you will be asked for some general information about this trial. 

Entering general information about a trial 
This window appears when you are designing a new trial, and also when you selected the 

“General Information on Trial” item from the “Trial Design” menu of the start screen. 

For a new trial, 

you need to 

enter the 

number of 

varieties in this 

trial as well as 

the number of 

replications and 

the width of the 

trial.  

Optionally, you 

can enter the 

(approximate) 

sowing date, the 

plot size and 

seeding rate. 

Please select 

either kg/ha or 

pl/ha. 
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A maximum of 400 plots per trial is possible with TrialWizard. This can e.g. be used for an 

unreplicated trial with 400 varieties, or 133 varieties in 3 reps.  

There is currently a maximum of 8 reps per trial. However, when more than 8 reps would be 

needed, just make a second trial with the same varieties. It is very easy to combine different 

trials with the same varieties into one statistical analysis (see Printing a results table with 

statistical analysis).  

TrialWizard needs to know how many plots wide this trial is, in order to print a map. If this 

trial here has 48 plots and is 12 plots wide, it is assumed that 4 plots are behind each other. 

After TrialWizard knows the size and width of the trial, a map will be drawn in yellow with 

plot numbers in each plot. 

When ready, save the information by pressing the ‘Save’ button. For a new trial, you will be 

asked for a folder in which you want to save this trial. Default is the “Trials” folder. 

For a new trial, many menu items from the start screen will remain dimmed and unavailable 

until you have entered the variety names and the trial design with appropriate plot numbers.  

More trials on a trial location 
Optionally, in the right part of the ‘General information’ window, you can select or type a 

trial location for this trial. If you select an existing trial location, the other trials on that same 

location will be shown in green rectangles, while the current trial is shown in yellow. If you 

type X and Y coordinates for plot nr. 1, the yellow map of the current trial will be drawn on 

the appropriate place. You can also double-click on the place in the grid where you want plot 

nr. 1 to be placed. 
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Entering or editing variety names 
 

From the “Trial design” menu, choose 

“variety names”.  

 

 

 

 

 

 

 

 

 

This will bring you to the following window: 

You can now read in variety 

names by hand, from a file or 

from the Windows Clipboard.  
Usually, it is easiest to select an 

existing list of names from another 

trial, or in Excel, Agrobase or 

other files by pressing the button: 

 

A standard file open dialog box 

will then be shown, in which you 

can select the file with the variety 

names you want. 

Names can be taken e.g. from an 

Excel file with sorted results of 

last year. Directly, or using the 

Windows Clipboard, you can paste 

them here into this trial. 

The first name coming from the 

file or from the Clipboard will 

enter at the selected item (here: 

starting at variety 6). So you can 

paste several groups of names after 

each other. 

Below, there are 3 buttons. 

The “Quit” button will bring you back to the start screen without saving the names. 

The “Save” button saves the variety names as entered. 

The “To Clipboard” button will put all variety names on the Windows Clipboard, so you can 

paste them into another trial. 
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Entering or editing the trial plan design with plot numbers 
From the “Trial design” menu, choose “Trial plan design”.  

This will bring you to the following window, showing the plot numbers per variety in field 

book sequence: 

Whenever possible, it is strongly 

advised to use a randomization for an 

alpha or lattice design by pressing the 

“Incomplete Blocks” button above. 

This example is a lattice design with 

3 replications, for which the design is 

produced by TrialWizard.  

When an optimized incomplete block 

design for this trial is not available, 

the “Incomplete Blocks” button does 

not appear. 

You can read in entry numbers by 

hand, one for each plot, for a new 

trial. Or edit entry numbers from an 

existing trial, e.g. when you need to 

correct the field plan due to mixing 

seed bags or a sowing failure. 

TrialWizard will display the variety 

name corresponding with the entry 

number you type. 

If you read in the entry numbers by 

hand, TrialWizard will propose block 

numbers as if this trial were a 

randomized block design. However, 

for an incomplete block design, you can enter block numbers by hand yourself, or press the 

“Start here New Block” button at the plot where a new (incomplete) block begins. 

Pressing the “Randomized Blocks” button above, will produce a new randomization for a 

randomized block design. It is advised, after saving, to print a map of this newly randomized 

trial and then manually edit plot numbers here again if replicates of any variety, by chance, 

appear too close to each other.  

A suitable trial design with entry and block numbers of an old trial can be used again in this 

trial. In the old trial, put the trial design on the Clipboard. In this current trial, push the “Paste 

from Clipboard” button above to paste all plot numbers. Then Save. 

Below, there are 3 buttons. 

The “Save” button saves the trial plan with variety and block numbers as shown. 

The “To Clipboard” button will put all plot numbers on the Windows Clipboard, so you can 

paste them into another trial. 

The “Quit” button will bring you back to the start screen without saving this trial plan. 
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Adding pedigree information or remarks for varieties 
Optionally, you could read in background information for each variety, such as its pedigree. 

The “Trial design” menu options “Mother lines, or pedigree” and “Father lines of hybrid” 

each give room for a 12-character designation to be entered. The option “Remarks per 

variety” gives room for a 24-character remark which could e.g. be used as an extended name 

for a variety. 

Reading in these designations can be done by 

hand, or copied from a file using the button 

 or pasted from the Clipboard. 

 

Later, you have the option to print these 

pedigrees behind the variety results. 

 

Also, trial results from different varieties with 

the same pedigree can be grouped and 

averaged, thus providing a better view on 

breeding value of parent lines. 

 

 

 

 

 

Printing a map of the trial 
In the “Trial design” menu, choose “Print Map of Trial” or type Ctrl+M. This gives: 

 

This trial map can be 

printed, or exported, by 

pushing one of the buttons 

below.  

 

This particular trial has 12 

plots side by side and 4 

plots behind each other. 

Plot numbers are 

according to field book 

sequence, going as you 

would probably walk to 

give notes. X- and Y- 

coordinates are shown 

beside and below the map, 

respectively. 
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Plot sequence for sowing of trials by plot seeders 
Sowing machines for field trials, like Ojord or Wintersteiger, require the seed bags in a 

certain sequence which is different from the field book.  

Often, groups of trials are sown together, with a unique X-Y tag for each plot. Such sowing 

plot numbers can be generated by TrialWizard. 

From the “Trial design” menu, select “Print plot nrs for sowing (+ labels)” You will then 

get the following window: 

The field-book plot 

number 1 is in the 

bottom-left corner of 

the trial. By pressing 

the appropriate 

buttons you can 

choose the preferred 

sowing sequence. 

Sowing could start on 

all 4 corners, in a plot 

of the trial or in an 

adjacent border plot. 

Double-clicking on a 

plot will make this the 

first plot to be sown.  

 

 

Pressing the “Print labels” button will allow you to design and print labels 

Pressing the “Print Overview” button will result in the following output: 

 

Here, the 

sowing plot 

numbers are 

given for this 

trial according 

to X and Y 

coordinates per 

plot.  

 

 

 

 

 

 

 

Sowing in the sequence as numbered here, will guarantee the trial lay out as planned. 
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Different plot sequences for harvesting or scoring 

Observations can be scored in field book sequence. However, harvesting of plots is often 

done in a different sequence than according to the field book plot numbers. Entering data into 

TrialWizard can be done in many different sequences, depending on the most practical way of 

operating on the field. 

To experiment with the different possibilities of plot sequences, choose “Print Plot nrs. for 

Harvesting (+ labels)” from the “Trial design” menu. You will then see: 

 

Press different radio buttons to see the plot sequence numbers associated with that harvesting 

order. In the example here, you see a possible cereal harvesting sequence of plots. 

Pressing the “Print Overview” button will show a screen with all field book plot numbers of 

each variety, with the corresponding harvest sequence number of plots. 

Pressing the “Print Labels” button enables you to design and print labels as follows: 

 

You can choose between some 100 commercial label sizes, or design your own label. Select 

optional info to be printed on the label, such as variety name, etc.. You can see a print 

preview of the label, before actually printing. 
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Entering (or editing) observations and yields 
Different observations per plot are made on the field and in the laboratory. Data are written in 

a field book or, e.g. when made with a hand-held computer, they will be stored in a file. To 

get the data in TrialWizard files, you could proceed as follows: 

From the “Results” menu, select “Enter or edit observations per plot” or type Ctrl+E. 

 

This will lead you to the following window (example forage crops): 

 

Observations already entered will be shown here, with dates of observations. Selecting one of 

these will allow you to edit the original data already entered.  

If a new observation or harvest should be entered, select the appropriate (green) check box. 

Difference between observation (left) and yield (right) 

You could enter all data and yields as observations on the left side if you prefer. However, 

entering yield information on the right side has specific advantages: 

• In the table of results, mean yields are calculated in mT/ha, whereas the mean of 

observations is just the mathematical mean of plots. 

 

E.g. for forage crops: 

• Entering fresh yields as well as dry matter percentages per plot will automatically 

generate a dry matter yield per plot. Corrections in original data will automatically 

work through for derived data. 

• Entering fresh yields as well as a quality percentage per plot, will automatically 

generate the quality yield per plot 

• Entering fresh yield, dry matter and quality data will enable e.g. to analyse the 

digestible dry matter yield of forage crops or the protein yield of pulses. 

 

E.g. for industrial chicory: 

• Entering % fructose and % glucose will automatically generate % inulin and degree 

of polymerisation. With the fresh root yield, it will also generate inulin yield. 

 

If you have crop-specific requirements for yield and quality calculations, please 

contact info@trialwizard.nl. 

mailto:info@trialwizard.nl
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After you have chosen an observation by selecting the appropriate check box, you will see: 

 

First, type or select the date of observation (left) and a description. 

Then, consider the entering sequence of the data. In the case of observations, this will usually 

be in the (default) field book sequence. However, harvesting sequence could be different. 

Select the appropriate radio button on the left for the sequence of entering data. 

If you enter data by hand, you could optionally enter the “format” of the data, to speed up the 

manual input. If you want to enter for example dry matter percentages like “13.6” and “14.2” 

then you should enter 3 digits per number and 1 digit behind decimal.  

After this, you only need to type “136” and “142” for plots. 

TrialWizard adds the decimal sign and advances one plot each time. 

 

On the right, you see the plot number, the variety name and the text box in which to enter the 

observation for that plot. Behind that plot, you 

will see the observations already entered for 

the other reps of the same variety, so you 

could instantly check any odd results.  

The plot numbers shown left of the variety name, are according to the chosen sequence of 

observation. When you press the “Save” button, however, a re-ordering of data is done by 

TrialWizard, as all data are saved in field book sequence. Pressing the “To Clipboard” button 

will not cause a reordering. Data will be put on the Windows Clipboard in the order as shown. 

Pushing the return key will move you to the next plot, whereas pushing the up-arrow key will 

bring you back to the previous plot. You can also use the scroll bar. 

Besides reading in plot data by hand, you can also paste data from the Windows Clipboard or 

get data from files stored e.g. by hand-held data capture devices, Excel, Agrobase, etc..  
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To retrieve data from files: 

1. Press the  button. This will open a standard Windows “Open File” 

window 

2. Search for the file with data you want to transfer. TrialWizard will then open this file 

and shows it as an Excel file (even if it was a text file or a database file).  

3. You are now asked to click with the mouse in the cell containing the observation 

date. You can press Cancel to skip this step. If the name of the opened file ended with 

a date (e.g. filename “Yields Winter wheat IV 2003 15-6-2003”, then this step is 

automatically skipped to save time. 

4. In the case of entering an observation, you are now asked to click with the mouse in 

the cell containing the description of the observation. For fresh yields or dry matter% 

it is unnecessary, so this step is skipped. 

5. Subsequently, you are asked to click with the mouse in the top cell of the range 

(column) containing the harvest sequence number or X-Y coordinates of plots.     

When you press Cancel, TrialWizard will assume fieldbook sequence is used. 

 
6. Finally, you are asked to click with the mouse in the top cell of the range containing 

the observations made. Starting there, TrialWizard will start reading downwards until 

a blank cell is reached, or until data for all plots have been found. Then, it will show 

the data in field book sequence. 

7. Check to see if indeed the correct plot data are assorted to the right varieties. 

 

When you press the ‘Save’ button, observations made for this trial are stored in the trial.twz 

file, per plot, in fieldbook sequence. After editing data, the edited data, when saved, replace 

the original ones. You cannot delete observations from a .twz file, but you could overwrite 

them with new ones. 
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Missing plots 

After data for all plots are entered for an observation, a “Missing Plot” button will appear: 

 

First, identify missing or clearly incorrect observations for a specific plot. Then scroll to focus 

that incorrect observation. Now press the “Missing plot” button. TrialWizard will calculate 

the best possible estimate for that pot, using advanced statistical techniques. This is preferable 

above just entering an average of the other reps of that same variety. 

TrialWizard remembers which plots have been missing. Plots with estimated values, rather 

than measured values, appear yellow instead of white in the typing box (see plot 42 above). 

Later, the analysis of variance is adapted to take the missing values into account. 
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Importing data from hand-held computers 

TrialWizard has many options to import data from files stored by hand-held computers, 

smartphones or other data-capture devices.  

Quite common is storage of data by hand-helds in an individual file per trial. Data can for 

example be stored in a sequential ASCII file with 'Return' between the plot data, or in a 

database with one record per plot, or in a kind of spreadsheet with plots in 

rows. Whatever the format, data can be imported easily by TrialWizard 

If data per plot are entered in random order, but with plot numbers along with the data, 

TrialWizard can import such data and sort 

according to the corresponding plot 

number.  

 It is often the most simple to program 

your hand-held to store the observations in 

a simple sequential file per trial, with the 

data (weights) in order of harvesting. This 

would also allow for using simple bar-

code labels just with a sequential number 

representing the order of harvesting of 

each plot. 

TrialWizard can import these weights and 

sort them according to plot numbers for 

any conceivable harvest sequence used.  

Sometimes cereal or maize people don't harvest per trial separately, but do a complete trial 

location with many different trials at once, storing all the yields into one file. Often they use 

X and Y coordinates (row and strip numbers) to indicate plots, regardless of the specific trial. 

Also in such a case TrialWizard can import data and allocate to the different trials and plots. 

Using Excel on your smartphone for observations 

Smartphones are all around and most can work with MS 

Excel or similar spreadsheet software.  

TrialWizard can export fieldbooks of your trials for use on 

smartphones. For this, choose option ‘Export Field book 

to Excel’ from the ‘Trial design’ menu. 

Store these field books in a folder, which will be 

synchronized with your PDA (for procedure, see your 

PDA manual).  Subsequently, the field books can be 

opened and used on your PDA by pocket Excel.  

As this fieldbook is in fact an Excel spreadsheet, you can 

record several observations per plot at the same time if 

you want, using your PDA on the field. Back in the office, 

synchronizing files will update the Excel files on the PC 

with TrialWizard 

Data importing from these Excel fieldbooks into 

TrialWizard is very straightforward, making use of procedures described at Entering (or 
editing) observations and yields 

Besides exporting ‘empty’ field books, TrialWizard can also export field books, partly filled-

in with your choice of observations already made for each plot of this trial. This is handy e.g. 

for checking observations recently done. For this option, select the ‘Filled-in Field book’ 

option from the ‘Results’ menu. 



 

 © Copyright 2002-2023  Beerepoot Consultancy B.V., Wageningen, the Netherlands                         17                                   

Checking observations made 
There are several ways to check the quality of the observations you entered. One is to print 

the observations per plot, next to the variety means, block effects and residual plot error. 

From the “Results” menu, select “Data per plot and Residuals”. Alternatively, you could 

press the button with the checkmark  in the start screen. 

Now select up to 2 observations, preferably related to each other.  

Subsequently, the following output will be shown: 

Here, you can 

quickly check for 

odd outliers in the 

results per plot. 

Residuals marked 

with an (*) are 

suspect. 

 

To correct them, 

you should use 

menu option: 

“Entering (or 

editing) 

observations and 

yields” from the 

‘Results’ menu 

 

 

The menu option “Variability on map of trial” will do something very similar, but now the 

deviation of a plot from the variety mean is printed in that plot on a map of the trial: 

Per row and per 

column in the trial 

field, you will see the 

average deviations of 

varieties in that row or 

column.  

A deviating column 

could indicate a 

spraying overlap or 

fertilizing mistake. A 

deviating row might 

be caused by e.g. 

different plot length in 

that row.  

Anyway, this mapped 

variability might help 

to spot problems and 

find a cause. 
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Printing a results table with statistical analysis 
From the “Results” menu, select “Report Table with statistics”. 

Now you first see a window which shows all observations and yields already entered. The 

lay-out of the right part of this window depends on the type of crop. You can change the type 

of crop in Entering general information about a trial. Here, a forage crop is shown: 

 

You can now select up to 15 observations, yields and totals you wish to report, by pressing 

the appropriate buttons. Each chosen observation or total will be a column in the report.  

 

For statistical analysis of a total of more observations, first press the “Start a Total or an 

Average” button (it will turn yellow), then select the observations or yields for this total. 

Press the button again when this total is complete. Subsequently, you can continue selecting 

other observations and totals. 

Often, a statistical analysis is needed for more trials together. For example, when combining 

results of a treated and an untreated trial, or of trials with the same varieties on several 

different locations or in different years. This is possible with TrialWizard, even when the 

statistical designs and number of replications of the trials are different. Up to 10 trials on 

different locations and different years can be combined into a joint statistical analysis, but 

only for the varieties these trials have in common. Make sure that variety names are spelled 

the same in the different trials to combine (see also Find and replace variety names).  

 

For statistical analysis of more trials together, press the “Add a trial to this list” button. You 

will then be enabled to choose additional trials. These will be shown under the “Which 

Trial?” heading. Clicking the button of a particular trial will show all observations and yields 

made for that trial. You can thus subsequently select observations from different trials, to be 

presented in 1 report table. You can also compose totals from different trials. 

After selecting the desired observations and totals, press the “Ready” button. You will see: 
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If in hindsight you 

would like to add 

more observations 

or totals, press the 

“Back to add 

observations” 

button or just click 

on the previous 

window (seen here 

in the back). 

If you want the best 

varieties on top, 

select the 

appropriate radio 

button to determine 

the observation or 

total for ranking. 

Pressing “No rank” 

means no sorting. 

In the window with selected observations, you can decide which ones need to be printed 

relative to the mean (98, 103 etc.) by selecting the appropriate leftmost check boxes. 

The description of observations and totals can be edited, shortened or translated if needed. 

Optionally, by clearly marking the check box before one or more varieties you can make 

these into Control Varieties. The mean of the “checked” varieties will then become “100” 

for results expressed relative to the mean. 

You can choose to add pedigree information or remarks to the printed results per variety. 

Press a button from the ‘Add variety info?’ box on the right.  

You can choose to group results per parent line or similar 

pedigree by pressing an “Average per parentline” button. 

Results will then be ranked according to group means, so the best 

pedigree groups will be on top. Individual varieties as well as group means will be printed. 

Many trial fields have local trends caused for example by 

fertility differences, drought, or winter damage. The 

‘Moving Mean’ or ‘Nearest Neighbour’ corrections 

may improve the results.  

In unreplicated trials, ‘Moving Mean’ will adjust plot observations using the mean of 8 

neighbour plots. In replicated trials, TrialWizard will find out whether ‘Moving Mean’ 

correction will improve results, and which number of neighbour plots would be optimal to 

minimize error variance.  

The ‘Nearest Neighbour’ method involves a covariance analysis of plot data with the 

‘residuals’ of neighbour plots, ‘residuals’ being the difference of a plot with the mean for that 

variety. Only in the case of a significant correlation of plot data on residuals of neighbour 

plots, an adjustment of results will be done. The nearest 2 neighbours within the same strip 

are tried, as well as the nearest 2 neighbours in front of and behind each plot in the same row.  

For poorly randomized trials, it is not a good idea to use Nearest Neighbours or Moving 

Mean. You can prevent these corrections by unchecking the ‘Try improvements…’ button.  

An Incomplete Block Design (IBD) can be analyzed as a Randomized Complete 

Block Design (RCB), by pressing the appropriate radio button.  
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After pressing the “Go ahead” button, you will see the results table with statistics: 

 

This is an example of a combined statistical analysis of 2 trials together. 

The results are presented in a simple word processor window. You can edit the results here, 

e.g. to remove lines, change codes into names, or change the text format or size using the 

“Format” menu. 

The column headers are explained below the results table. Mean results of varieties are 

presented, as well as some statistical information (c.v., LSD, F-values) for each observation 

or total (each column).  

The F-value for varieties indicates the variation between varieties relative to the random error 

in the trial. Higher F-values indicate better quality observations. A “+” or “-“ sign indicates 

whether F-values are statistically significant or not (at the 5% level).  

TrialWizard first tries a standard RCB or Incomplete Block analysis, and subsequently tries if 

Moving Mean or Nearest Neighbour analysis brings any improvement in accuracy. In the 

results table you will find indications of which ANOVA method was used as most optimal. 

The optimum analysis may vary per observation or total, as the example shows.  

'RCBD' means analysis of variance as a Randomized Complete Block Design 

'Latt.'  means analysis as Lattice design, ‘alpha’ indicates analysis as alpha design. 

'M.M 2' means use of Moving Mean, with 2 neighbours on either side (4 in total) 

'NNhor' means Nearest Neighbour analysis with only 'horizontal' neighbours at either side 

 'NNver' means N-N analysis with only 'vertical' neighbours behind and in front of the plot 

'NNh+v' means Nearest Neighbour analysis with all 'vertical' and 'horizontal' neighbours used 

‘Comb’ indicates a combined statistical analysis of results of more trials. 

 

Results can be printed, but also stored as Word or Excel file, by pressing one of the buttons 

below. Storing as Excel file enables tasks such as making special graphs not provided by 

TrialWizard, or processing the variety results into records for a database, or calculating a 

complex index per variety.  

 

Hit the ‘Print’ button to use the default printer and the default page setup. Using the ‘Print…’ 

option from the ‘File’ menu will enable you to change the printer setup. 
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Presenting correlation between 2 observations or totals 
From the “Results” menu, select “Graph correlation 2 characteristics”, or Ctrl+G 

Then, select 2 observations or totals as you would do for a Report Table with statistics. The 

output will be like this: 

 

 

 

The variety numbers are plotted in the graph. When printed, the variety numbers with their 

names, X-value and Y-value will be shown on paper below the graph. You can also see them 

on screen, if you pull the bottom- right corner of the above window downwards. 

LSD-values for the X and Y axis are shown graphically in the top-right corner of the graph. If 

the distance between 2 variety numbers is larger than the length of the LSD-line, the 

difference is significant. 

The correlation coefficient between X and Y variety means is given in the bottom-left corner. 

In this example, there was a significant correlation between the total yield on a sand location 

with the total yield of the same varieties in an other trial on a clay soil. 
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Presenting unique strengths of a few varieties 
Especially for marketing purposes, detailed and lengthy tables are not the optimum. It is 

better to visually present the essentials of a variety with only a few controls. 

From the “Results” menu, select “Bar-graph results 5 varieties”.  

Then, select up to 5 most meaningful observations or totals, as you would do for a Report 

Table with statistics. First select the most important observation or total.  

Later, you will arrive at the following window: 

 

In this 

example, only 

3 observations 

are chosen. 

You should 

edit the 

description, to 

make it as 

short and 

meaningful as 

possible. 

 

Then, select first the variety you want to focus on. In addition, select up to 4 other varieties as 

controls 

Press “Go ahead” 

You will now see: 

 

 

 

In this view, it is 

instantly clear that the 

strong point of variety 

S2Bt is its Rust 

resistance. 

 

This output can be 

printed, or put on the 

Windows Clipboard 

for transferring to 

marketing literature. 
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Showing seasonal performance of varieties 
In turf grasses, or other crops with similar observations or harvests repeated in time, it can be 

interesting to visualize the relative performance of varieties during a longer time period. 

From the “Results” menu, select “Seasonal graph results 5 varieties” 

Then, select a series of comparable observations.  

Choose up to 5 varieties for the graph. 

The resulting graph is presented below. In this example, the variety Parade has a good overall 

performance, but seems relatively weaker in summer. The Candidate is weaker overall, but 

stronger in summer. This graph therefore can help positioning a variety and present its 

stronger points. 

 

Hit the ‘Print’ button for printing on the default printer using the default page setup. Using the 

‘Print…’ option from the ‘File’ menu will enable you to change the printer setup. 
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Searching for varieties 
To find out in which trials a certain variety or group of varieties has been tested, there is a 

search option in TrialWizard. From the ‘Edit’ menu, choose “Find variety”, or press the 

‘Find’ button of the start screen. This will reveal the following: 

After typing the names of varieties, 

press ‘Search’. The names of the trials, 

containing all varieties typed, will 

appear as shown here. There is an 

empty checkbox in front of each trial. 

TrialWizard starts searching in the 

volume \TrialWizard\Trials\ and its 

subfolders. To search additional trials 

on other locations (e.g. network), press 

the ‘Search in other locations’ button. 

To analyse results of trials, double-

click the desired trials shown. Make 

sure the checkbox is checked in front of 

each of the trials to include in the 

results.  

Then, select the ‘Results’ menu option 

of your choice. 

 

Head to head comparison of 2 varieties 
You may wish to focus on the difference between 2 varieties using all test results available. 

Select the ‘Find varieties’ option, and type the 2 variety names. Then press ‘Search’. Select 

all trials found, as explained in the ‘Searching for varieties’ chapter above. Subsequently, 

select e.g. the ‘Bar-graph’ option from the ‘Results’ menu to produce the desired output. 

 

Find and replace variety names 
To change e.g. a breeder’s code into an accepted variety name in all trials, proceed as follows: 

 

From the ‘Edit’ menu, choose ‘Find and 

replace variety name’. 

 

 

 

Then, type the old and the new variety name in the appropriate text fields and press the 

‘Search’ button. 

 

TrialWizard will replace the name in all 

trials where the old variety name was used, 

and shows these trials. Search and replace 

will start in \TrialWizard\Trials\. 


